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Sissejuhatus 

 

Eelarve programm on mõeldud kogu firma ja üksikute osakondade  

eelarve koostamiseks ning täitmise jälgimiseks. Tegelikud täitmise summad  

võetakse Taavi raamatupidamise programmist kas kogu firma või üksikute 

osakondade käibeandmikest. 
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Programm võimaldab koostada mitu erinevat eelarvet kas kogu firmale 

või ka eraldi üksikutele osakondade eelarved. Koostatavaid eelarveid võib olla mistahes 

arv . Näiteks kogu firma eelarve struktuur võib erineda osakondade eelarvete 

struktuurist. 

Aruannetesse tuuakse eelarve jaotamine kuude kaupa , täitmine kasvavalt ning 

täitmine kvartalis eraldi kuude kaupa. 

Ühele eelarve reale saab kirjeldada täitmise 15 raamatupidamise kontolt. 

Eelarve programmi  võib kasutada ka mitmelt töökohalt korraga, s.t. võrguversioonina. 

Aruandeid on võimalik lihtsalt eksportida nii Excelisse kui Word’ i. 
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Programmi töö üldpõhimõtted 

 

Eelarve programmis on võimlik kirjeldada mistahes arv eelarveid, st. igale 

kirjeldatavale eelarvele omistatakse oma kood. 

Eelarve  programm kasutab oma tööks tegelikke raamatupidamisandmeid kas 

kogu firma (allüksus=0 ) või konkreetse osakonna / allüksuse käibeandmikust, st. igale 

kirjeldatud eelarve reale võetakse täitmine tegelikust raamatupidamisest. 

 Eelarve programmis on vaja kirjeldada eelarve struktuur, s.t. eelarve read, 

kirjeldused, sisestada igale eelarve reale summa ning määrata, millistelt kontodelt 

raamatupidamisest tuleks võtta täitmine, samuti , kas täitmine võetakse konto deebet või 

kreedit käibest. Ühele eelarve reale on võimalik kirjeldada kuni 15 kontot.  

 Eelarve programmis on eraldi protseduur , mille ajal tuuakse tegelikud summad 

eelarve programmi. Kui ümberarvestuse protseduur on teostatud, võib koostada 

aruandeid. 

Aruannetesse tuuakse eelarve jaotumine kuude kaupa, eelarve ja täitmine kasvavalt ning 

eelarve ja täitmine ühe kvartali sees eraldi kuude kaupa. 

 Eelarve summasid saab programmi sisestada nii kuude kui kvartalite kaupa / 

sõltub programmi häälestamisest. 
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Programmi käivitamine 

 

 

 Programm käivitub käsuga weelarve.exe, mille tulemusena avaneb tarkvara 

TAAVI käivitusekraan. 

 

Kuupäevaks pakub programm arvuti kuupäeva, kui see pole õige, tuleks kuupäev 

parandada - liikuda kuupäeva väljale ja trükkida õige kuupäev. Hiire klõps kasutajanime 

väljal viib Teid kasutajanime tühjale väljale, kuhu tuleks trükkida kasutaja nimi. 

Esmakordsel programmi kasutamisel on kasutaja nimeks TAAVI. Pärast kasutaja nime 

trükkimist tuleb teha hiireklõps võtmesõna väljal ning trükkida sinna võtmesõna. 

Esmakordsel programmi käivitamisel on selleks  kuus X -tähte. Ekraanile tuuakse tärnid, 

et keegi teine juhuslikult ei näeks võtmesõna. Programmis on võimalik igale kasutajale 

eraldi defineerida nii kasutajanimi kui tema salasõna. Kuid esmakordsel käivitamisel on 

nendeks vastavalt TAAVI ja kuus x-tähte. 

P.S. Pärast esmakordset programmi sisenemist oleks mõistlik lisada kasutajate 

nimekirja korrektne kasutaja nimi ja tema võtmesõna, siis proovida selle kasutaja nimega 

programmi siseneda ning  kui kõik on korras, kustutada kasutaja Taavi kasutajate 

nimekirjast ära (vt . Seadistused -> Kasutajad , programmis File -> Seadistused -> 

Kasutajad )  

Pärast võtmesõna trükkimist, tuleb vajutada klahvile ENTER või teha hiireklõps 

nupukesel ‘Alustame tööd’, et programm saaks käivituda.  

Ekraanile tuuakse programmi peamenüü. 

Ülemises ekraani servas on menüüde pealkirjad, millest igaühest avaneb 

alammenüü.  

Menüüdel saab liikuda , kui teete hiireklõpsu sobival menüül. Aktiivse peamenüü või 

alammenüü taust on tume (…sinine).  

Hiireklõps sobival peamenüül avab alammenüü. 

Menüüdel liikumiseks võib kasutada hiirt (või noole klahve) ning liigutada teda menüül 

üles - alla. Peamenüül olles võib hiirt liigutada vasakule-paremale, mille tulemusena 

avatakse ekraanil järgmine alammenüü. Menüü käivitamiseks tuleb hiire nooleke viia 

soovitud menüü reale ja teha üks hiire klõps , mille tulemusena avatakse vastav 

andmetabel või käivitub dialoog või alustatakse mingit tegevust.  
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Registreerimine 

Eelarveprogrammi litsentsi registreerimiseks saate vajalikud andmed (Litsentsi 

omanik, Toote kood ja Registreerimiskood) registreerimiskaardilt, mis asub programmi 

karbis koos installeerimise CD ja juhendiga.  

Registreerimist on vaja programmis teostada seetõttu, et installeerimisketastel on 

programm registreeritud Taavi Tarkvara Demo’na, mis tähendab, et programmi 

kasutamine on piiratud. 

 

Registreerimiseks käivitage menüü FILE -> Seadistused-> Registreerimine. Ekraanile 

tuuakse registreerimisekraan., mis tuleb täita järgnevalt: 

 

Litsentsi omanik - firma nimi, mille Te kirjutasite registreerimiskaardile. Sisestage 

palun täpselt sama moodi nagu kaardile märkisite - suured-väikesed tähed, tühikud. 

Toote kood - sisestage toote kood, mis Teile teatati, tavaliselt WPV1AAMMDD , kus 

AA-aasta , MM -kuu , DD- päev 

Registreerimiskood - sisestage Teile teatatud registreerimiskood . 

NB! Registreerimiskoodis pole tühikuid ega nulle . Nullide asemel on O-tähed !!!  

 

Kui kõik lahtrid on korrektselt täidetud, tehke nupukesel Registreeri hiireklõps. 

Kui kõik läks õigesti , teatab programm : Eelarveprogramm edukalt registreeritud. 

Juhul, kui kõik ei läinud edukalt, teatab programm: Registri kontrollsumma vale ning 

programm läheb demo režiimi. 

 

Kontrollige toote ja registreerimiskoodi, äkki läks midagi valesti ja proovige uuesti. 

Võite programmi kinni panna ja uuesti käivitada.  

 

Kui ka teisel ega kolmandal korral registreerimine ei õnnestu, võtke ühendust müüjaga. 

 

 

 

 

Peamenüüde kirjeldus 

 

Menüüd on programmis üles ehitatud põhimõttel - vasakult paremale - andmete 

sisestuselt aruanneteni. Kaks kõige vasakpoolsemat menüüd on tavalised windows  

programmi menüüd File ja Edit, milledes on võimalik seadistada programmi, muuta  

kirjakuju ja  milledes asuvad vähemkasutatavad registrid, nagu printerid või kasutajate  

defineerimine. Pärast Edit menüüd tulevad järgmistena  : 
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 registrid   

 eelarvete kirjeldamine  

 eelarvete vaatamine 

 aruanded  

ning nende järel vähemkasutatavad menüüd: 

 aken 

 abi.  

 

Toome siinkohal peamenüüde sisulise kirjelduse: 

File – tööperioodi , jooksva allüksuse valimine, seadistused , andmete hooldus, kasutajate 

sisestamine, programmi registreerimine.   

Seadistused : 

 kasutajad - palgaprogrammi kasutajate registreerimine 

 kirjakuju - tabelite, sisestustekstide ja püsitekstide kirjakuju (inglise keeles font) 

muutmine 

 registreerimine – programmi litsentsi registreerimine ettevõttele (vt. ka 

registreerimine ) 

 printerid - tööks kasutatava printeri kirjeldamine (tavaliselt pole vaja midagi 

kirjeldada ) 

 värvid - programmi värvide muutmine 

Andmete hooldus : 

 andmebaasi koopia 

 uute indeksfailide koostamine 

 andmebaaside korrastus ja kontroll ( e. andmestruktuuride kontroll)  

 koopia taastamine  

Lõpeta: töö lõpetamine programmiga 

Edit -  taasta, kopeeri , lõika , esimene, järgmine , eelmine , viimane kaart 

Registrid - programmi tööks vajalikud registrid  e. teatmikud - 

 eelarved   

 allüksused 

 alajaotused 

 kontod 

 

Eelarvete  kirjeldamine   - erinevate eelarvete kirjelduste , eelarve summade 

sisestamine nii kogu firmale, kui ka üksikutele allüksustele 
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Eelarvete vaatamine – eelarvete ja täitmise vaatamine tabeli kujul ilma aruandeid 

koostamata 

Aruanded – aruannete koostamine eelarve jaotumise kohta kuude lõikes, eelarve 

täitmise kohta kasvavalt , eelarve täitmise kohta ühes kvartalis kuude lõikes  

Aknad - töö akendega - aknad kinni, aknad kaskaadi jne. 

Abi - abitekst ja info programmi kohta - 

*  programmi versiooni number ja kuupäev; 

*  info programmi autori kohta; 

*  info litsentsi omaniku kohta. 
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Töö andmetabelitega 

 

 Andmete sisestamine programmi toimub alati kindlate ühesuguste reeglite 

alusel. Programmis tuuakse kõik andmed ekraanile tabeli kujul, mida edaspidi 

nimetame andmetabeliteks. Näiteks kontoplaanis on toodud kõik kontod tabeli kujul. 

Tabeli kujul on andmeid ekraanil võimalikult palju ning nad on ülevaatlikud. 

Andmetabelisse andmeid sisestada (andmeid muuta või lisada) pole võimalik.  

Andmete sisestamine toimub programmis läbi ekraanide, mille käivitab hiire klõps 

Vaata nupukesel (programmis illustreeritud silma kujutisega, samuti võib kasutada enter 

klahvi ). 

Andmetabelit võib kasutada mingi kindla rea otsimiseks ja vaatamiseks. 

Andmetabelites on võimalik otsida andmeid tabeli veergude järgi. Näiteks asute Te veeru 

konto 

kõige esimesel real. Selles veerus saate otsingut teostada konto numbri järgi. Kui vajutate 

mingit 

numbrit , näiteks ‘ 1’, avaneb otsingu väli ‘Leia…’, kuhu saate 

trükkida otsitava konto numbri ning pärast hiireklõpsu  jääb programm otsitud 

konto numbri reale. 

 

NB! Kõiki andmetabeleid  saab sorteerida veergude järgi, millede veeru 

pealkiri on SINISE KIRJAGA !!!  

 

Otsida asukoha reast allapoole saab kõikides veergudes. 

 

Andmetabelis on võimalik kasutada nn. kiirklahve liikumiseks andmetabeli esimesele 

või viimasele reale, need on tähistatud nupukeste real nooltega - ‘Esimene’, ‘Eelmine’, 

‘Järgmine ’, ‘Viimane’. 

 

Andmete sisestamine toimub nn. ekraanidesse, mitte andmetabelitesse.  

 

Andmete sisestamisel kasutatakse programmis nn. nupukesi, mis asuvad 

nupukeste ribal. 

 

Näiteks nupuke, millel on kiri  lisa , lisab andmerea , kui teha nupukesel hiireklõps. Enne 

nupukestel - Vaata, Kustuta, Valik, Uus  - hiireklõpsu tegemist, tuleb avada mõni 

andmetabel,  
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kuna vastasel korral ei tea programm, millisesse andmetabelisse tuleb rida lisada . 

Avatud andmetabelis (andmetabel on ekraanil ) saab kasutada järgmisi nupukesi:  

 

Lisamine - lisab  uue andmerea , näiteks eelarve rida jne. 

Vaata - saab parandada rida, millel andmetabelis asuti. 

Kustuta - kustutab tabelist rea (vt. kustutamise protseduur), millel asuti. 

Ekraani väljadel saab liikuda kas TAB klahvi kasutades või tehes hiire klõps sobival 

väljal (võib kasutada ka nool-alla klahvi). SHIFT-TAB klahv viib eelmisele väljale.  

Valik - avab registri, millest saab andmeid valida. Kui asutakse numbri väljal, avab 

Valik kalkulaatori, kui asutakse kuupäeva väljal, avatakse kalender.    

 

Andmetabelite kirjeldust e. tabelisse toodud veerge on võimalik muuta. Näiteks soovite 

Te 

töötajate tabelisse lisada veergu sünnipäev. Selleks tuleb Teil teha parem hiireklõps tabeli 

pealkirja real. Ekraanile avaneb aken menüüga: 

 Lisa veerg 

 Kustuta veerg 

 Veeru pealkiri 

 Veeru joondamine 

 Salvesta veerud 

 

Tabelisse veeru lisamiseks tuleb valida ‘Lisa veerg’, ning ekraanile toodavast 

andmeväljade 

loetelust valida sobiv väli tehes sellel hiirklõpsu. Enne välja tabelisse lisamist võib muuta 

ka 

veeru pealkirja trükkides Pealkirja lahtrisse soovitud veeru pealkirja. Ok nupukesel 

hiireklõps 

lisab soovitud veeru andmetabelisse. Selleks, et ka järgmisel korral avaneks Teie poolt 

kirjeldatud andmetabel, tuleb tabeli kirjeldus salvestada. Selleks tuleb teha parem 

hiireklõps 

tabeli pealkirja ribal ning menüüst valida ‘Salvesta veerud’.  

 

‘Kustuta veerg’ kustutab tabelist veeru, mis on aktiivne. 

‘Veeru pealkiri’ - võimalus muuta ainult veeru pealkirja, mis on aktiivne. 

‘Veeru joondamine’ -  joondab veeru pealkirja kas vasakusse või paremasse serva või 

keskele. 
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‘Taasta algseis’ - kustutab kõik Teie poolt sisestatud ja salvestatud tabeli kirjeldused 

ning 

paneb programmi algseisus olnud tabeli kirjelduse sellele andmetabelile, milles olete , 

mitte 

kõikidele. 

Andmetabelite veerge on võimalik ka tõsta teise kohta, selleks tuleb veeru pealkirjal olles  

vajutada vasakut hiireklahvi ja seda all hoides lohistada veerg sobivasse kohta. Kindlasti 

tuleb 

pärast veeru kirjeldus ka salvestada.   
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Klaviatuuri kasutamine 

 

Programmi saab kasutada ka ainult klaviatuuri abil. Siis on klahvidel järgmised 

tähendused : 

F3 – lisa 

F2 – muuda 

Esc – väljumine (ekraanilt, tabelist) 

Enter – käivita  ( rea , menüü vaatamine, avab registri ) . Näiteks konto kaardil lahtris 

grupp  

avab gruppide nimekirja, millest grupi valimiseks tuleb liikuda sobiva grupi reale 

ja vajutada enter.  

Tab – järgmisele väljale 

Shift - Tab – eelmisele väljale 

Nool – alla – järgmisele väljale 

Nool üles – eelmisele väljale 

Tühik – märgib lahtrisse linnukese 

Alt – avab menüü  
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Üldkasutatavad nupud 

 

 

 Programmiga töötamisel kasutatakse ühesuguste tegevuste sooritamiseks 

alati samu nupukesi või klahve / klahvikombinatsioone. Tegevuste nupukesed on 

toodud andmetabelite ülaservas nupukeste ribal - nupukesel on ka kiri, mida selle 

nupukesega 

teha saab . 

 Programmis TAAVI kasutatakse järgmisi nupukesi ja klahve : 

 

Lisa Lisamise nupuke , F3 lisab andmerea tabelisse, mis on avatud  

Vaata Muutmise nupuke , 

F2 

avab ekraani vaatamiseks ja 

muutmiseks 

Salvestamine, tagasi, 

välja 

Sulgemise nupuke 

,Esc 

sulgeb ekraani, tabeli - ristike paremal 

ülaservas  

Valik Avab registri , Enter registrist andmete valimiseks väljale 

avab kalkulaatori numbri väljal 

avab kalendri kuupäeva väljal 

edasi-tagasi liikumiseks 

menüüdel ja väljadel 

Hiireklõps väljal 

TAB 

SHIFT-TAB  

Nool-alla 

Nool-üles 

nii menüüdel kui ekraani väljadel 

järgmisele väljale 

eelmisele väljale 

järgmisele väljale 

eelmisele väljale 

Kustuta Kustutamise nupuke kustutab andmerea, millel  asutakse  

Enne kustutamist küsib programm - 

‘Kas olete kindel, et soovite andmerida 

kustutada- vastates JAH kustutatakse 

rida, millel asutakse, EI katkestab 

kustutamise.  

Andmetabelist aruanne Printeri  nupuke trükib aruande andmetabelist, mis 

avatud on 

Kalender  Kalender avaneb, kui olete kuupäeva 

väljal ja teete Valik nupukesel hiire 

klõpsu. Sobival kuupäeval olles tehke 

OK nupukesel hiireklõps. Kuupäeva 

väli täidetakse kalendrist valitud 

kuupäevaga. 
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Kalkulaator numbri 

lahtris 

 Kalkulaator avaneb, kui numbri väljal 

olles teete Valik  nupukesel hiire 

klõpsu. Edit->Copy salvestab soovitud 

numbri  ning CTRL->V (Paste) toob ta 

programmi väljale. 

Eelarved   Avab erinevate 

eelarvete koodide 

registri  

Kiirvaliku nukuke, mis annab 

võimaluse vaadata /kustutada/lisada  

eelarvete koode eelarvete koodide 

registrist ,ilma eelarvete registrit 

peamenüüst   

Kalkulaatori märk   Käivitab kõikide 

eelarvete koodide 

kõikide allüksuste 

ümberarvestuse   

Nupuke käivitab kõikide erinevate 

eelarve koodide ja kõikide allüksuste 

ümberarvestuse e. täitmise toomise 

eelarve ridadee.   

 

NB! Alati on ekraani kõige ülemisel real toodud nupud, mida antud hetkel on 

võimalik kasutada !  

 

Nupukesed on dubleeritud ka hiire parema klahviga. Olles andmereal ja vajutades 

paremat hiireklahvi, on võimalik kasutada järgmisi tegevusi: 

muuda 

lisa 

kustuta 

tabel kinni  

 

Olles ekraanil mõnel väljal ja vajutades hiire paremat klahvi, on võimalikud järgmised 

tegevused: 

Cut  

Copy 

Paste 

Delete 

Select all 

Vali - avab registri, millest saab väljale sobiva väärtuse valida 
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Kustutamine ja muutmine 

 

Programmis võib andmeid kustutada ja muuta alati kasutaja, kes on 

nad sisestanud. 

Andmetabeli rea e. näiteks ühe eelarve rea  kustutamiseks tuleb 

andmetabelis liikuda hiirega sobivale reale ja  klõpsutada kustutamise nupukesel 

(või teha parem hiireklõps ja valida menüüst ‘kustuta rida’). Programm alustab 

terve rea kustutamisega. Ekraanile tuleb küsimus: 

  

Kas soovite kindlasti seda rida kustutada ?  

Enne kustutamist programm hoiatab, et JAH valik kustub terve andmerea. 

Enne 

JAH valimist tasub alati kontrollida, kas Te olete ikka sellel real, mida 

kustutada 

soovite. Rida, millel asute on teistsuguse värviga, kui ülejäänud. Jah 

valimiseks 

tuleb teha hiireklõps JAH peal . Andmerida kaob andmetabelist. Kui Te ei 

soovi 

andmerida kustutada, siis tehke hiireklõps vastusevariandi EI peal. 

 

Andmete parandamiseks tuleb andmetabelis olles liikuda parandada 

soovitud reale (konto jne.) ja teha ‘Vaata’ nupukesel hiire klõps või topelt 

hiireklõps andmereal. 

Programm avab andmete ekraani, millel võib andmeid parandada juhul, kui 

see on lubatud ( ettenähtud ) .  

 

TAB (SHIFT-TAB) või hiirega tuleb liikuda väljale, mida soovitakse 

parandada 

ning trükkida sinna uus väärtus ja liikuda järgmisel väljale. Tagasi 

eelmisele väljale saab SHIFT-TAB klahve kasutades (või hiireklõps 

sobival väljal).   
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Trükiprotseduuri kirjeldus 

 

Aruannete ja teatmike trükkimine programmis koosneb kahest osast: 

1. aruanne koostatakse ja tuuakse ekraanile 

2. ekraanil olev aruanne saadetakse printerisse. 

Enne aruande printerisse saatmist tuuakse ta alati ekraanile, et oleks 

võimalik ta üle vaadata ja kontrollida . Aruandeid on võimalik lihtsalt 

eksportida erinevatesse formaatidesse, näiteks tabel , Word 

tekstiredaktorisse, tavaline tekstifail jne. Enne aruande koostamist 

küsitakse, kas aruannet soovitakse ekraanile, printerile või eksportida.   

Kui ekraanil olev aruanne sobib printerisse saatmiseks, siis pange 

printer töökorda ja klõpsutage printeri ikoonil. Programm trükib aruanded 

printerisse, mis on Windows all häälestatud .  

Enne aruande koostamist küsitakse ekraanil, mitu koopiat ja 

milliseid lehti soovitakse trükkida. Sisestage koopiate arv, kui soovite 

rohkem kui 1 koopiat. 

Kõikidest programmis olevatest andmetabelitest (teatmikest) saab väljatrüki, kui 

teete andmetabelis olles printeri ikoonil hiireklõpsu.  

 

 

Aruannete selekteerimine 

Programmi juurde kuulub hulk erinevaid aruandeid , mida saab käivitada menüüst 

Aruanded -> ‘Muud aruanded ‘ või ‘Lisaaruanded’. Aruannete hulgast on võimalik välja 

valida need, mis sobivad tööks kõige enam. Kõik aruanded on esialgu tähistatud rohelise 

ringikesega, mis tähendab, et nad kõik on lubatud. Kõikide aruannete ekraanile toomiseks 

tuleks teha täpike lahtrisse ‘Kõik’. 

Aruande keelamiseks tuleb liikuda aruande nimetuse peale nii, et ta muutub tumesiniseks 

ning teha parem – hiireklõps . Ekraanile tekib menüü, millest tuleb valida ‘Keela’ , mille 

tulemusena kaob aruanne ‘Minu omad’ nimekirjast ära. Kui teha täpike lahtrisse ‘Kõik’ 

tekib nn. ‘keelatud aruanne’ nimekirja punase ringikesega. Aruande lubamiseks tuleb 

jällegi liikuda aruande nime reale ning teha parem – hiireklõps ja valida ‘Luba aruanne’, 

mille tulemusena ilmub aruande ette roheline täpikene.  

Menüü ‘Trüki’ võimaldab koostada aruannete nimekirja ning selle ka printerile 

väljastada. 

Menüü ‘Kopeeri eelistused’ võimaldab ühe kasutaja poolt välja valitud aruandeid 

kopeerida teistele kasutajatele. Selleks tuleb programmi siseneda teise kasutaja nime ja 

võtmesõnaga . Parem hiireklõps toob ekraanile küsimuse :’Kopeerime jooksvad 

eelistused kasutajalt ‘ .Lahtrisse tuleb sisestada kasutaja nimi, kelle aruannete eelistusi 

soovitakse jooksvale kasutajale kopeerida. Hiireklõps OK nupukesel toob ekraanile 

küsimuse, :’Kas kopeerime kasutajanimele [kasutaja kaks e. jooksev kasuta ] kasutaja 

[kasutaja üks ] aruandeelistused ?’ . Hiireklõps OK nupukesel kopeerib 
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aruandeeelistused. Kui märkida lahtrisse ‘Kõik’ täpike, siis on punase ringiga märgitud 

samad aruanded, mis on punase ringiga märgitud kasutaja üks poolt.  

 

 

 

Aruande tingimuste muutmine 

 

Aruannete käivitamistingimusi on võimalik kasutajal ise muuta. Selleks tuleb viia kursor 

aruande nimele nii, et aruande nimi muutub tumesiniseks ning teha linnuke lahtrisse 

‘Muudame aruande tingimusi’ . Hiireklõps ‘Trüki’ nupukesel käivitab aruande. Pärast 

aruande parameetrite sisestamisest tuleb ekraanile lisatabel, kus on kirjas aruande 

käivitamise tingimused. Näiteks võib olla aruanne piiratud kuude vahemiku, allüksuse 

numbri vm. tunnuste järgi. 

Tingimust saab muuta kui liikuda muuta soovitud rea peale ning teha ‘Edit’ nupukesel 

hiireklõps. Tingimuse muutmise ekraanil on järgmised lahtrid: 

And/or  - jah / või 

Field   - andmebaasi väli või aruande jaoks spetsiaalne väli 

Comparision - suurem/väiksem/võrdne/väiksem võrdne/suurem võrdne jne. 

Compared to - võrreldav millega ? e. andmebaasi väli vm. aruande jaoks loodud väli 

Hiireklõps OK nupukesel salvestab tingimuse tingimuste tabelisse. 

Tingimusridu  saab lisada , kui valida ‘Append’ valik. Vahele saab ridu panna  

‘Insert’ nupukest kasutades ning kustutada saab ‘Delete’ nupukest kasutades.  
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Eelarved 

 

Eelarvete registris kirjeldatakse erinevate eelarvete koodid . Eelarvele omistatakse  

Järjekorranumber , kood ja nimetus. Edaspidi, kui eelarve read on kirjeldatud, saab nii 

kirjeldust kui ka täitmist läbi selle ekraani vaadata.  

Eelarve programmi menüüsse Registrid -> Eelarved  tuleb kirjeldada erinevate eelarvete 

koodid . 

 

Uue rea lisamiseks tuleb nupukesel ‘uus’ teha hiireklõps (suur roheline pluss märk 

ikooniribal) ning tühjad väljad tuleb täita järgmiselt: 

 Järjekorra number – eelarve järjekorranumber  - ei tohi olla null  

 Eelarve kood  – eelarve kood , 10 sümbolit, märgitakse aruannetesse 

 Eelarve nimetus  – eelarve nimetus / kirjeldus  

 

Kui kasvõi 1 eelarve kood on registrisse sisestatud, võib eelarve ridu kirjeldama hakata. 

Eelarvete registris printeri nupp trükib eelarvete nimekirja.  
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Allüksused 

 

Eelarve programm on tihedalt seotud Taavi Raamatupidamise programmiga, 

seetõttu allüksuste registris näidatakse raamatupidamises kasutusel olevaid allüksuseid. 

Eelarve programmis saab allüksuseid ainult vaadata – lisada ja kustutada ei saa. 

Jooksvat allüksust saab määrata menüüst File - > Allüksuse valik . Ekraanile tuuakse 

allüksuste nimekiri (sama, mis menüüst registrid -> allüksused ) , Liikuge sobivale 

allüksuse reale ning tehke OK nupukesel hiireklõps. Programmi ekraani kõige alumisel 

serval näidatakse jooksva allüksuse numbrit.  
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Alajaotused 

 

Allüksuste struktuur võib olla eelarve programmis erinev raamatupidamisest.  

Menüüs Registrid -> Alajaotused saab kirjeldada allüksuste struktuuri eelarve 

programmi jaoks, näiteks kuulub allüksuse  number 100 koosseisu ka allüksused 101 ja 

102 , sel juhul tuleb jooksvaks allüksuseks valida allüksus 100 ning registris vajutada 

lisa nupukesele, mille tulemusena avaneb ekraan, milles programm pakub 1. lahtrisse 

jooksva allüksuse (meie näites 100 ) ja 2. lahtrisse tuleb valida allüksus, mis hakkab 

kuuluma esimese allüksuse struktuuri (meie näites 101 ). Sel juhul liidab programm 

allüksuse nr.100 summadele ka allüksuse nr. 101 summad . 
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Kontod 

Eelarve programm on tihedalt seotud Taavi Raamatupidamise programmiga, 

seetõttu kontode registris näidatakse raamatupidamises kasutusel olevaid kontosid . 

Kontosid on vaja valida eelarve ridadele. 

Eelarve programmis saab kontosid ainult vaadata – lisada ja kustutada ei saa. 
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Eelarvete kirjeldamine 

 

Eelarve programmi kõige tähtsam menüüpunkt on eelarvete kirjeldamine, kuna 

siin menüüs kirjeldatule rajaneb kogu ülejäänud tulemus. Menüüs Eelarvete 

kirjeldamine on sama palju ridu, kui menüüs Registrid -> Eelarved , st. kui lisada uus 

eelarve kood , siis lisandub automaatselt rida ka menüüsse Eelarvete kirjeldamine, et 

oleks võimalik uuele eelarvele koodile eelarve ridu lisada. P.s. Null järjekorranumbriga 

eelarve ei ilmu menüüsse.  

Eelarve rea kirjeldus koosneb kahest ekraanist: 

Eelarve punkti kirjeldus – üldine rea kirjeldus, kus pannakse paika , millistelt kontodelt 

või  

punktidelt summa saadakse   

Jagunemine allüksustele – eelarve summa jaotamine konkreetsetele allüksustele 

 

Tehke sobival eelarve koodil hiireklõps. Juhul, kui alustate tööd esmakordselt, on 

andmetabel tühi, vastasel korral tuuakse ekraanile varem sisestatud selle eelarve koodi 

eelarve read. Uue rea lisamiseks tuleb teha lisamise nupukesel hiireklõps ning alustada 

tühjade lahtrite täitmisega Eelarve punkti kirjelduse ekraanil: 

 Eelarve punkt – eelarve punkt koosneb peapunktist ja allpunktist . Esimesse 

lahtrisse sisestage peapunkt , näiteks 1 ja teise lahtrisse alampunkt . Pea – ja 

alampunktidega saab kujundada eelarve struktuuri, näiteks : 

1.01 

1.02 

1.03 

… 

1.10 – punkt 1 kokku 

2.01 

2.02 

2.03 

… 

2.20 – punkt 2 kokku 

jne. 

 

 Summeerib – valige sobiv tunnus , kas ‘Tuludesse’ või ‘Kuludesse’ vastavalt sellele, 

kas  

eelarve rida on tulude või kulude poolel 

 Täitmise tüüp – valige sobiv variant: 
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Käibesumma – täitmise summa saadakse kontode käivetest raamatupidamise 

käibeandmikust 

Punktisumma – täitmise summa saadakse eelnevate punktide summeerimisel 

Tühi vaherida – reale ei ole midagi vaja summeerida, trükitakse ainult tekst aruandesse , 

näiteks  

TULUD , mis tähistab tulude algust 

 Nimetus – eelarve rea nimetus, mis tuuakse aruannetesse 

 Aasta koondsumma – eelarve punkti kogu aasta eelarve summa kõikidele 

allüksustele kokku 

 Lahtritesse kolmes veerus 15.real tuleb sisestada kontod ja punktid, mida sellele 

eelarve reale summeeritakse : 

1.veerg näitab  tehet - + või – 

2.veerg määrab tüübi – deebet ; kreedit ; punkt 

3.veerg määrab konto või punkti numbri 

Mõned näited :  

 + Kreedit  40001 reale summeeritakse konto numbri 40001 kreeditkäibed 

 --  Deebet 70001 reale arvutatavast summast lahutatakse konto 70001 deebet käive 

 Punkt 112  rida võrdub punkti 1.12 summaga 

 

Punkti summa puhul pole eelarve summat vaja sisestada , summa võetakse vastava punkti 

realt. 

Punktid peavad olema kirjeldatud kronoloogiliselt, st. punkt, mille summat kasutatakse , 

peab olema kirjeldatud eespool.   

 

Konto ja punkti numbri valimiseks registrist kasutage paremat hiireklahvi – Vali või 

enter klaviatuurilt. 

 

Jagunemine allüksustele ekraanil tuleb sisestada kuude kaupa eelarve summad 

konkreetsetele allüksustele. Uue rea lisamiseks tuleb lisamise nupukesel teha hiireklõps 

ning täita tühjad väljad: 

 Allüksus  - valige allüksuse number, millele eelarve summasid sisestama hakkate 

 Eelarve - > Jaanuar…Detsember – sisestage eelarve summad kuude kaupa , mis on 

määratud sellele konkreetsele allüksusele . Kui kvartal on sisestatud, tekib kvartali 

lahtrisse automaatselt kvartali summa. 

 Täitmine – siia veergu ei saa summasid sisestada, kuna ümberarvutamise ajal tuuakse 

nendesse lahtritesse tegelikud täitmise summad raamatupidamisest  või arvutatakse 

punktide summadest vastavalt kirjeldusele ekraanil ‘ Eelarvepunkti kirjeldus’ 
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Ekraan sulgub paremas servas asuvast ristikesest. Esimesel ekraanil oleva lahtri Aasta 

summa alla ilmub summa, mis näitab, palju aasta summast on veel allüksuste vahel 

jaotamata. 

 

Eelarve kirjelduse saab välja trükkida, kui teete andmetabelis (kui kõik ühe eelarve koodi  

erinevad eelarve read on ekraanil ) printeri nupul hiireklõpsu. 
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Eelarvepunktide import 

 

Importimise protseduuri võib vaja minna mitmel juhul, näiteks : 

 kui alustatakse programmiga tööd esmakordselt ning eelarve struktuur on 

väljatöötatud mõnes teises programmis    

 eelarve summad ja struktuur töötatakse pidevalt välja Taavi Eelarve programmi 

väliselt 

Taavi Eelarve programm on suuteline importima andmeid menüüsse ‘Eelarve 

kirjeldamine’ TEKSTIFAILIST  struktuuriga: 

Eelarvekood;punkt1;punkt2+nimetus;summa01;summa02;…;summa12 

kus: 

Eelarve kood – eelarve kood registrist ‘Eelarved’ - 10 sümbolit 

Punk1 – esimene eelarve punkt e. peapunkt 

Punkt2+nimetus – teine eelarve punkt e. alampunkt ;alates 9.’st positsioonist eelarve 

punkti nimetus 

 p.s. Eelarve punkti nimetus imporditakse ainult siis, kui eelarve punkti 

lisatakse  

punktide nimekirja e. seda punkti ei ole eelarve kirjelduses enne olemas 

e. importimisel programm küsib , kas lisada see eelarve punkt 

Summa01…summa12 – on aasta eelarve summad kuude kaupa 

 

dBase FAILIST struktuuriga: 

EELARVE – eelarve kood registrist ‘Eelarved’ - character 10 

PUNKT1 - esimene eelarve punkt e. peapunkt – character 2 

PUNKT2+Nimetus - teine eelarve punkt e. alampunkt – character 8 ja suurem ; alates  

9.positsioonist eelarve punkti nimetus 

p.s. Eelarve punkti nimetus imporditakse ainult siis, kui eelarve punkti lisatakse 

punktide nimekirja e. seda punkti ei ole eelarve kirjelduses enne olemas e. 

importimisel programm küsib , kas lisada see eelarve punkt 

P01 

P02 

… 

P12  - on aasta eelarve summad kuude kaupa – Numeric 12.2 

 

Importida saab menüüst ‘Eelarvete kirjeldamine’ -> ‘Eelarvepunktide import’ . 

Programm avab akna, milles on võimalik määrata fail , mida importida soovitakse ja 

failitüüp – Tekstifail või dBase . Otsige oma arvutisüsteemist fail ning tehke tema peal 
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hiireklõps, seejärel OK nupukesel hiireklõps. Programm alustab faili importimist. Juhul, 

kui failis olev eelarve punkt on eelarve kirjeldusest puudu, küsib programm , kas punkt 

lisada või mitte, valige sobiv variant . Juhul, kui failis on teistsugused summad, kui 

eelarve kirjelduses, siis summad muudetakse eelarve kirjelduses. Importimise tulemust 

saate kontrollida menüüst ‘Eelarvete kirjeldus’ , kui  valite eelarve koodi, millesse 

andmeid importisite. 
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Eelarvete vaatamine 

 

Menüüst Eelarvete vaatamine on võimalik vaadata nii eelarvet ja täitmist  , kui 

ka panna programm ümberarvutust tegema , s.t. raamatupidamisest tegelikke täitmise 

summasid eelarvesse tooma . 

Menüüs Eelarvete vaatamine  on sama palju ridu, kui menüüs Registrid -> 

Eelarved , st. kui lisada uus eelarve kood , siis lisandub automaatselt rida ka menüüsse 

Eelarvete vaatamine , et oleks võimalik uuele eelarvele teha ümberarvestust. 

Ekraanile tuuakse valitud eelarve ja jooksva allüksuse eelarve summad kuude 

kaupa. Juhul, kui tabel on tühi, siis pole sellele eelarve koodile ühtegi eelarve rida 

sisestatud ega ümberarvestust teostatud. Sel juhul tuleb eelarve koodile sisestada 

kirjeldus menüüst Eelarvete kirjeldamine .   

Andmetabeli kõige vasakpoolsemas veerus on toodud eelarve kirjelduse punktid 

ning teistes veergudes on toodud eelarve summad kuude kaupa. Eelarve täitmise 

vaatamiseks tuleb Vaata nupukesel teha hiireklõps . Avataval ekraanil on toodud 

jooksva allüksuse valitud eelarve rea eelarve ja täitmise summad kuude kaupa.  

Täitmise lahter täidetakse summaga ümberarvestamise ajal. Täitmise summaks 

võetakse kas konto käibest summa või kujuneb ta punktide summadest vastavalt 

etteantud kirjeldusele (menüüst  Eelarve kirjeldamine ).  

Ümberarvestamiseks tuleb menüüs Eelarve vaatamine teha sobival eelarve koodil 

hiireklõps ning avatud tabelis teha seejärel parem hiireklõps . Ekraanile toodud menüüst 

valige sobiv variant: 

Ümberarvutus jooksvale – arvutab üle jooksva allüksuse valitud eelarve koodi 

jooksvale  

perioodile  

Ümberarvestus kõigile – arvutab ümber erinevad eelarved jooksvale allüksusele 

jooksvale  

perioodile  

 

P. S. Nupukeste ribal oleval kalkulaatoril hiireklõps käivitab ümberarvestuse kõikidele 

allüksustele ja kõikidele eelarve koodidele jooksvale perioodile.     

 

Allüksuse eelarve jaotumist kuude kaupa on võimalik välja trükkida, kui Eelarve 

vaatamise andmetabelis teha printeri nupukesel hiireklõps. 
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Käibeandmik 

 

Menüüst Käibeandmik on võimalik vaadata jooksva allüksuse käibeandmikku 

jooksvale perioodile e. võrrelda täitmise summat kontodel olevate deebet ja kreedit 

käivete summadega. Sellest andmetabeist võtabki eelarve programm tegeliku täitmise.  

Eelarve programmis ei ole käibeandmikuga võimalik mingeid protseduure teha , 

st. ei saa ridu lisada, kustutada ega käibeandmikku ümber arvestada, seda kõike tohib 

teha ainult raamatupidamise programmist. 
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Eelarve jaotamine 

 

Menüüst Aruanded - > Eelarve jaotamine on võimalik koostada aruanne 

jooksvale allüksusele  erinevate eelarve koodide kaupa . Aruande käivitamisel küsitakse 

ekraanilt eelarve koodi. Sisestage sobiv eelarve kood ( vt. registrid -> eelarved ). 

Aruandesse tuuakse jooksva allüksuse eelarve read ning eelarve summad kuude kaupa.  
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Eelarve täitmine 

Menüüst Aruanded - > Eelarve täitmine on võimalik koostada aruanne 

jooksvale allüksusele erinevate eelarve koodide kaupa . Aruande käivitamisel küsitakse 

ekraanilt eelarve koodi ning kuude vahemikku . Sisestage sobiv eelarve kood ( vt. 

registrid -> eelarved ) ja periood kuust – kuuni . Aruandesse tuuakse jooksva allüksuse 

 eelarve read  

 eelarve summad  

 täitmise summad 

 hälve 

 täitmise protsent  

KASVAVALT .  
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Kvartalieelarve 

 

Menüüst Aruanded - > Kvartalieelarve on võimalik koostada aruanne jooksvale 

allüksusele erinevate eelarve koodide ja ühe kvartali kohta . Aruande käivitamisel 

küsitakse ekraanilt eelarve koodi ning kvartali numbrit . Sisestage sobiv eelarve kood ( 

vt. registrid -> eelarved ) ja kvartali number 1…4 . Aruandesse tuuakse jooksva 

allüksuse 

 eelarve read  

 eelarve summad  

 täitmise summad 

 hälve 

ERALDI KUUDE KAUPA ÜHE KVARTALI KOHTA .  
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Muud aruanded 

 

Menüüst Aruanded -> Muud aruanded on võimalik koostada kõiki eelpool 

menüüs olevaid aruandeid ning lisaks eelarve koodide registri ja eelarve punktide e. 

eelarve kirjelduste väljatrükke.  
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Töökuu 

 

 

Menüüst File - > Töökuu on võimalik vahetada töökuud. Ekraani 

kõige alumisel ribal on näha, millises aastas ja kuus programm asub. 

Tööperioodi õige valik on oluline, kuna ümberarvutus tehakse 

konkreetselt ainult jooksvale kuule. Hiireklõps menüül avab kuude 

nimekirja, millest tuleb valida sobiv kuu e. teha kuu nimel hiireklõps. 
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Tööaasta 

 

 

Menüüst File -> Tööaasta  on võimalik vahetada tööaastat . Ekraani 

kõige alumisel ribal on näha, millises aastas ja kuus programm asub. 

Tööperioodi õige valik on oluline, kuna ümberarvutus tehakse 

konkreetselt ainult jooksvale kuule ja aastale . Hiireklõps menüül avab 

menüü : 

 eelmine aasta – programmi jooksvaks aastaks saab üks aasta vähem, 

kui  

olemasolev 

 järgmine aasta – programmi jooksvaks aastaks saab üks aasta rohkem , 

kui  

olemasolev  
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 Uue aasta alustamine 

Menüü File - > Töökuu -> Uue aasta alustamine  käivitamisel 

kopeeritakse jooksva aasta eelarve punktid järgmise aasta eelarve punktide 

faili e. programmis toimub jooksva aasta lõpetamine ja uue aasta 

alustamine. 
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Jooksva allüksuse valik 

 

 

Menüüst File - > Allüksuse valik on võimalik määrata jooksvat allüksust . Allüksuse 

määramine on oluline, kuna ümberarvestused toimuvad jooksvale allüksusele, samuti 

eelarve vaatamisel näidatakse jooksva allüksuse eelarve ja täitmise summasid. 

Menüü käivitamisel tuuakse ekraanile allüksuste nimekiri, millest valimiseks tuleb 

liikuda sobivale reale ja teha OK nupukesel hiireklõps. Ekraani alumisel serval on näha, 

mis on programmi jooksev periood (kuu ja aasta ) ning jooksev allüksus.   
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Andmehooldus 

 

 

 Andmehoolduse menüüd tuleb kasutada alati, kui on olnud 

voolukatkestus või arvuti on seisma jäänud ja te olete pidanud poole 

programmi töö pealt tegema arvutile alglaadimise või teile tundub, et 

programm ei käitu nii, nagu kogu aeg . 

Samuti tuleb pärast pikemat andmete sisestamist võtta andmetest 

koopia disketile. Programmis on erinevad andmehooldus menüü punktid, 

mida saab kasutada erinevates situatsioonides , enamkasutatavad on : 

 andmebaasi koopia 

 uued indeksid 

 andmebaaside korrastus  

Kõiki andmehooldus menüüsid saab käivitada peamenüüst FILE ja 

sealt Andmete hooldus. 

Uued indeksfailid kustutab kõik CDX laiendiga failid ning genereerib nad 

uuesti. 

Andebaaside korrastus kustutab andmebaasidest tühjad / mittevajalikud 

kirjed.  
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Andmebaasi koopia 

 

 

 

 Koopia tegemiseks tuleb valida menüü File -> Andmete hooldus -> 

Andmebaasi koopia. 

Programm teatab, et hoolduse ajaks peavad kõik teised kasutajad töö lõpetama 
programmiga. 

Tehke hiireklõps OK nupukesel. Programm teeb koopia ning teatab, kui koopia 
tegemine on lõppenud. 

 

Reservkoopia käsurida tuleb programmile sisestada parameetrite menüüpunktist  

File -> Seadistused -> Parameetrid  1.ekraanil olevasse lahtrisse 

Reservkoopiakäsk  

Reservkoopia käsurida sõltub sellest, millist koopia tegemise programmi kasutatakse. 

 

Toome mõned näited: 

zip c:\taavi\[programmi nimi]\koopia\koopia -rp *.*   -x *.cdx *.exe *.tmp *.txt *.zip *.rp5 
*.dll *.hlp *.cnt 

[ programm zip.exe on tasuta kasutamiseks ] 

Käsurea taha trükitud failide laiendid tähendavad, et nende laienditega failid jäetakse 
koopiast välja – nendest failidest ei ole vaja koopiat teha. Neid faile saab taastada ( 
(uuesti arvutisse kopeerida).  

Loodava koopiafaili nimi või salvestuskataloogi nimi peab igal programmil olema 
erinev, vastasel korral salvestatakse iga kord eelmine koopiafail uuega üle kõikide 
programmide korral. 

Salvestuskataloog tuleb arvutisse eelnevalt luua. 

 

Oluline on, et koopia tehakse failidest, mille laiendid on : 

*.dbf 

*.fpt 

*.mem 

*.ini 

 

Näiteks: 

zip c:\taavi\koopia\eelarve%KUUPAEV% *.dbf *.fpt *.ini *.mem 
 

7za a c:\taavi\koopia\eelarve%KUUPAEV% *.dbf *.fpt *.ini *.mem 
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Uued indeksid 

 

 Uute indeksite menüüpunkti tuleb kasutada juhul, kui programmi töö ajal on 

olnud  

voolukatkestus või arvuti on programmi töö ajal mistahes põhjusel seisma jäänud.  

Samuti juhul, ,kui Te olete programmi töö ajal olnud sunnitud tegema arvutile  

alglaadimise. Uute indeksite menüü punkti peal hiire klõps kustutab kõik indeksfailid ( 

kõik failid, mille laiend on CDX ) ning programm koostab need siis ise uuesti. 

Olenevalt andmete hulgast võib see tegevus võtta mõningase aja - mõned minutid. 

 Uusi indeksfaile saate koostada peamenüüst File ja sealt Andmete hooldus -> 

Uued indeksid. 
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Baaside korrastus 

 

 Baaside korrastuse protseduur on programmis ettenähtud andmebaaside 

korrastamiseks.  

Protseduur likvideerib andmebaasidest kustutatud ja mittevajalikud kirjed. Baaside 

korrastust saab teha peamenüüst File  ja sealt Andmete hooldus -> baaside korrastus .  
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Printerid 

 

Programm kasutab aruannete jm. trükiste trükkimiseks WIN alla häälestatud 

printerit, mida on võimalik vaadata ja ka häälestada menüüst File -> Seadistused  ja sealt 

Printerid. Ekraanile tuuakse kasutusel oleva printeri kirjeldus.  
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Kasutajad 

 

Kasutajate andmetabelisse kirjeldatakse kõik programmi kasutajad. igale kasutajale  

sisestatakse tema võtmesõna. Kasutajate andmetabel on mõeldud selleks, et keegi peale 

oma töötajate ei saaks programmi sisse ega andmetele ligi. See on andmete kaitseks. 

Kasutajaid saab lisada peamenüüpunktist File -> Seadistused -> Kasutajad. 

Uue kasutaja lisamiseks tuleb kasutajate andmetabelis olles teha lisamise nupukesel  

hiireklõps, mille tulemusel programm küsib kõigepealt uut kasutajanime ( peab olema  

kuus tähte pikk).Trükkige uus kasutajanimi ning tehke OK nupukesel hiire klõps ,  

mille tulemusena on ekraanil küsimus uue kasutaja võtmesõna kohta. 

Trükkige uue kasutaja võtmesõna ja tehke OK nupukesel hiire klõps.  Ekraanile tuleb  

küsimus kasutajataseme kohta. kuna programmis pole kasutajatele kättesaadavad  

menüüpunktid tasemetega piiratud, siis tuleb siin programmis kasutajatasemeks 

alati trükkida 99 ja teha OK nupukesel hiire klõps. 

Sellega on uus kasutaja sisestatud. 

Uus kasutaja saab nüüd oma kasutaja nime ja võtmesõnaga programmi sisse. 
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Raamatupidamisprogrammiga sidumine 

 

Eelarve programm tuleb siduda raamatupidamise programmiga, vastasel korral ei ole 

eelarve programmil võimalik tegelikke eelarve täitmise summasid kuskilt võtta. 

Sidumine tähendab seda, et eelarve programmile sisestatakse raamatupidamise 

programmi asukoht arvutisüsteemis e. kataloog koos loogilise ketta tähega. Selleks, et 

seda teha saaks, on vaja eelarve programm käivitada võtmega param e. käsurida näeks 

välja selliselt: 

Weelarve.exe param 

Programmi tuleb siseneda tavalise kasutaja nime ja parooliga . Menüüs File peab olema 

kättesaadav menüü Parameetrid.  

Lahtrisse 

Taavi raamatupidamisandmete asukoha kataloog 

Tuleb sisestada raamatupidamise kataloog arvutis , näiteks 

T:\TAAVI\BILANSS\ 

Andmete salvestamiseks tuleb teha hiireklõps OK nupukesel. 

Seadistuse õnnestumise kontrollimiseks kasutage menüüpunkti Eelarve vaatamine -> 

Käibeandmik , ekraanile peab tulema jooksva allüksuse ja jooksva perioodi 

käibeandmik raamatupidamise kataloogist.     
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Lõpetamine 

 

Programmist tuleb alati lahkuda, kasutades seda menüü punkti. Kui teha 

hiireklõps menüül FILE -> Lõpeta, suletakse korrektselt andmebaasid ja programm küsib 

, kas 

soovite töö lõpetada ning kui teete vastuse variandil JAH hiire klõpsu, suletakse 

programm. Kui Te arvutiga rohkem tööd teha ei soovi, võite arvuti välja lülitada.  

 

NB! KUI PROGRAMM ON LAHTI E. EKRAANIL ON TAAVI TÖÖMENÜÜ 

VÕI ANDMETABELID, SIIS ARVUTIT EI TOHI KINNI VAJUTADA !!!!! 
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Info 

 

Menüü Abi -> Taavi info  on mõeldud üldinformatiivse info jagamiseks 

programmi 

versiooni, autorite, kasutaja jm. kohta. Seda menüüd on vaja kasutada juhul, kui 

programmi hooldajad paluvad teil näiteks läbi telefoni ette lugeda, mis versiooni Te 

kasutate .Tehke menüül  ‘Info’  hiire klõps ning ekraanile tuleb tekst, mida võite lugeda 

info saamiseks.  

 

 


